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Introduction

This demonstration guide follows the list on page 2 which shows  

the functions of the N6153A & W6153A measurement applications.  

Each demonstration is given a brief description of its function and the 

corresponding measurement steps on the signal generator and/or 

signal analyzer. 
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All of the RF transmitter measurements  

as defined by the DVB-T/H/T2 

standard, as well as a wide range of 

additional measurements and analysis 

tools, are available with a press of a 

button (Table 3). These measurements 

are fully remote controllable via the 

IEC/IEEE bus or LAN, using SCPI 

commands. 

Analog baseband measurements are 

available on the MXA signal analyzer  

equipped with BBIQ hardware. 

Supported baseband measurements 

include all of the modulation quality, 

power stat CCDF, and IQ waveform 

measurements.

Table 1. One-button measurements provided by the N/W6153A measurement application

Technology DVB-T/H DVB-T2

Measurement application N6153A-2FP,  

W6153A-2FP

N6153A-3FP,  

W6153A-3FP

X-Series analyzer PXA, MXA, EXA, CXA PXA, MXA, EXA, CXA

Measurements

Channel power

Shoulder attenuation

Spectrum mask with analog TV in  

adjacent channel

●

●

●

●

●

●

Adjacent channel power ● ●

Spectrum emission mask ● ●

Power statistic CCDF ● ●

Spurious emission ● ●

Modulation accuracy

RMS EVM (%) ● ●

Peak EVM (%) ● ●

Position of peak EVM ● ●

RMS MER (dB) ● ●

Peak MER (dB) ● ●

Position of peak MER ● ●

RMS mag error (%) ● ●

Peak mag error (%) ● ●

Position of peak Mag error ● ●

RMS phase error (deg) ● ●

Peak phase error (deg) ● ●

Position of peak phase error ● ●

Frequency error (Hz) ● ●

Tx power (dBm) ● ●

Amplitude Imbalance ● ●

Quadrature error (deg) ● ●

Phase jitter (rad) ●

Carrier suppression (dB) ●

SNR (dB) ●

TPS power ratio (dB) ●

Data power ratio (dB) ●

MER/EVM vs. subcarriers/frequency ● ●

MER of data (dB) ● ●

MER of pilot/TPS (dB) ●

MER of P2 Pilot/L1-Pre/L1-Post/Cont 

Pilot/Scat Pilot/FC Pilot

●

Amplitude vs. subcarriers (dB) ● ●

Phase vs. subcarriers (deg) ● ●

Group delay vs. subcarriers (ns) ● ●

Channel impulse response (dB) ● ●

BER results ●

TPS decoding ●

L1 signalling ●

MER monitor ● ●

Measurement Details
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Demonstration Preparation

Minimum equipment  
coniguration requirements
The demonstrations below use an 

X-Series signal analyzer and the  

N5182A MXG vector signal generator. 

Keystrokes surrounded by [ ] indicate 

front-panel keys; keystrokes surrounded  

by { } indicate softkeys located on the 

display. 

Product type Model number Required options

MXG vector 

signal  

generator

N5182A  

(Firmware revision 

A.01.20 or later)

 – 651, 652 or 654 – internal baseband generator 

(30 M/60 M/125 MSa/s, 8 MSa)

 –  019 – Upgrade baseband generator memory to 

64 MSa (recommended)

Signal Studio 

for digital 

video

N7623B QFP or  

QTP Advanced DVB-

T/H/C/J.83 A/C 

N7623B ZFP or ZTP 

Advanced DVB-T2

(software version: 

2.2.7.0 or later)

Please check N7623B signal studio  

Web page for the latest version  

www.keysight.com/find/signalstudio

X-Series  

signal 

analyzer

N9000A1, N9010A, 

N9020A, or N9030A 

firmware revision 

A.07.xx or later

Recommended:

 – EA3 – Electric attenuator, 3.6 GHz

 – POx – Preamplifier

 – P0x (P03, P08 (P07 for CXA))

 – B25 – Analysis bandwidth, 25 MHz  

(for analysis over 10 MHz up to 25 MHz)

 – BBA – Analog baseband IQ inputs  

(for analog baseband IQ analysis)

Required:

 – 503, 508, 507 (EXA and CXA), 513 or 526–513 

and 526 not available on CXA

X-Series  

DVB-T/H 

Digital Video

N6153A – N9010A,  

N9020A, N9030A

W6153A – N9000A 

only

Required:

 – 2FP: DVB-T/H measurement application, fixed 

perpetual license

 – 3 FP DVB-T2 measurement application, fixed 

perpetual license

OR

 – 2TP: DVB-T/H measurement application, 

transportable license

 – 3 TP DVB-T2 measurement application, trans-

portable license

Controller 

PC for Signal 

Studio for 

digital video1

 

Install N7623B to generate and download the 

signal waveform into the Keysight MXG via 

GPIB or LAN (TCP/IP)—please refer to the 

online documentation for installation and setup

1. Keysight X-Series PXA/MXA/EXA/CXA signal analyzers can be used as the controller PC to install 

the N7623B Signal Studio software and download waveforms into the MXG via LAN or GPIB.

Helpful tip:

Update your instrument firmware and software to 

the latest version, at

www.keysight.com/find/xseries_software

www.keysight.com/find/signalstudio

http://www.keysight.com/find/signalstudio
http://www.keysight.com/find/xseries_software
http://www.keysight.com/find/signalstudio


5

N7623B Digital 

Video Signal Studio

10 MHz Ref

LAN/GPIB

MXG 

RF Out

X-Series 

signal 

analyzer 

RF InFigure 1. Demonstration setup 

Demonstration Setup

Connect the PC,  
X-Series, and MXG

Connect a PC (loaded with Keysight 

N7623B Signal Studio for Digital 

Video software and Keysight I/O 

libraries) to the N5182A MXG via 

GPIB or LAN. Follow the Signal Studio 

instructions to complete the connec-

tion, and then perform the following 

steps to interconnect the X-Series 

analyzer (see Figure 1 for a graphical 

overview):

A. Connect the MXG RF output port  

to the X-Series signal analyzer  

RF input port

B. Connect the MXG 10 MHz Out  

to the X-Series signal analyzer  

Ext Ref In port (rear panel) 
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Demonstrations

Demonstration 1: 

Set up Signal Studio for 
Digital Video to generate 
DVB-T/H/T2 signals

The Keysight Technologies, Inc. 

N7623B Signal Studio for Digital 

Video is a Windows-based utility that 

simpliies the creation of standards-

based or customized DVB-T/H and 

DVB-T2 signals. The waveform is 

downloaded into the MXG vector 

signal generator, which generates  

RF or IQ signals.

The settings of DVB-T/H and DVB-T2 

signals under test are as follows:

DVB-T/H settings

Standard:  DVB-T

Frequency:  474 MHz

Channel bandwidth:  8 MHz

FFT size:  2 K

Modulation type:  16QAM

Alpha:  1

GI (guard interval):  4

Transmission modes:  Hierarchical

HP/LP code rate:  2

DVB-T2 settings (Signal PLP)

P1 type:  SISO

Frequency:  474 MHz

Channel bandwidth:  8 MHz

PAPR type:  No PAPR

GI (guard interval):  1/128

FFT size:  32 K

Pilot pattern:  PP7

Carrier mode:  Extended

Data symbol number:  7

L1 modulation type:  64QAM

Number of frames per superframe:   2

PLP settings

Modulation format:  256QAM

Constellation rotation:  On

FEC type:  Normal (64 K)

LDPC code rate:  3/5

Number of TI (time interleaving) 

blocks per interleaving frame:    3

FEC block number:  26

Instructions Keystrokes

On the MXG:

Preset the MXG

Check the IP address

[Preset]

[Utility] {I/O Config} {LAN Setup}

On the Signal Studio software:

Run the Keysight Signal Studio 

for digital video

Double-click on the Digital Video shortcut on the desk-

top or access the program via the Windows start menu

Verify the software is commu-

nicating with the instrument via 

the GPIB or LAN (TCP/IP) link

To establish a new connection, click on the {System} 

pull-down menu at the top of the Signal Studio program 

window. Next, select {Run System Configuration Wizard}

To generate DVB-T/H signals:

Select the DVB-T/H format
Click on the {Format} pull-down menu at the top of the 

Signal Studio program window. Next, select {DVB-T/H}

Set the parameters of the signal 

generator with center frequency 

474 MHz, amplitude –20 dBm,  

RF Output turned on, and ALC On

Click Signal Generator at the left on the Explorer menu. 

Instrument Model Number: N5162A/N5182A 

Press [Preset] green button at the top. 

Frequency = 474 MHz, Amplitude = –20 dBm, 

RF Output = On, ALC = On

Confirm the waveform setup 

from upper level

Click Waveform Setup to see the fundamental waveform 

signal setups, set DVB-T/H common parameters as follows: 

Oversampling Ratio = 1, Mirror Spectrum = Off,  

Quadrature Angle Adjustment = 0 deg,  

I/Q Gain Balance = 0 dB

Set a test signal for  

demonstrations

Click Carrier0 under Waveform Setup on the left of the 

explorer menu. Set the parameters of the signal to be 

transmitted on right side of the menu. Figure 2 shows 

the Signal Studio settings after the setup done

To generate DVB-T2 signals:

Select the DVB-T2 format
Click on the {Format} pull-down menu at the top of the 

Signal Studio program window. Next, select {DVB-T2}

Set the parameters of the signal 

generator with center frequency 

474 MHz, amplitude –20 dBm,  

RF Output turned on, and ALC On

Click Signal Generator at the left on the Explorer menu.

Instrument Model Number: N5162A/N5182A

Press [Preset] green button at the top.

Frequency = 474 MHz, Amplitude = –20 dBm,  

RF Output = On, ALC = On

Confirm the waveform setup 

from upper level

Click Waveform Setup to see the fundamental waveform 

signal setups, set DVB-T2 common parameters as follows:  

Oversampling Ratio = 1, Mirror Spectrum = Off, 

Quadrature Angle Adjustment = 0 deg,  

I/Q Gain Balance = 0 dB

Set the general DVB-T2  

parameters for carrier 0

Click Carrier0 under Waveform Setup on the left of the 

explorer menu. Set the parameters of the signal to be 

transmitted on the right side of the menu. The Carrier0 

settings should look like Figure 3 

Set the PLP0 parameter

Click PLP 0 under Carrier0 on the left of the explore 

menu. Set the parameters according to the settings of 

the signal under test on the right side of the menu.  

The PLP 0 settings should look like Figure 4

Download and save settings:

Download the signal to the MXG Click  on the top tool bar. If you encounter any errors, 

please refer to the online help of Signal Studio software 

Save the signal file for future use File > Save Setting File > DVB.scp (create filename)

Export the waveform file for  

future use

File > Export Waveform Data > DVB.wfm (create

filename)
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Figure 2. DVB-T/H signals setup in the Keysight Signal Studio software

Figure 3 Carrier 0 settings for DVB-T2 signal 

Figure 4. PLP 0 settings for DVB-T2 signal
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Demonstration 2:

Channel power 

The channel power measurement has 

three views: RF spectrum, shoulder 

attenuation, and spectrum mask. 

The RF spectrum view measures 

and reports the integrated power in 

a DVB-T/H/T2 defined bandwidth 

and power spectral density (PSD) 

displayed in dBm/Hz or dBm/MHz. 

Shoulder attenuation is used to  

characterize the linearity of the OFDM  

signal without reference to the  

spectrum mask. 

The spectrum mask view compares 

the input signal against the spectrum 

mask defined in ETSI EN 300 744 for 

the condition of analog TV signal in 

adjacent channel. 

Figure 5. Channel power measurement with RF spectrum view 

Figure 6. Channel power measurement with shoulder attenuation view

Instructions Keystrokes

On the X-Series:

Select DVB-T/H with T2 mode [Mode] {DVB-T/H with T2}

Set the center frequency [FREQ Channel] {Center Freq} {474} {MHz}

Choose DVB-T mode and set channel 

bandwidth

[Mode Setup] {Radio Std} {DVB-T}

[Mode Setup] {Channel BW} {8 MHz}

Select channel power measurement  

(RF spectrum default)
[Meas] {Channel Power}

Switch to shoulder attenuation view [View/Display] {Shoulder Attenuation}



9

Figure 7. Diagram for spectrum mask measurement on DVB-T/H/T2 transmitter without output 

filter

Figure 8. Diagram for spectrum mask measurement on a DVB-T/H/T2 transmitter without an 

external filter

Spectrum mask view

The dynamic range of the RF output 

of a real DVB-T/H with T2 transmitter 

typically exceeds the dynamic range 

of the analyzer. Therefore, the direct 

measurement result is always “FAIL” 

and cannot reflect the real RF output. 

To measure the spectrum mask of the 

transmitter’s RF output, there are two 

methods.

Method 1:  When the DVB-T/H/T2 

transmitter has an output filter, the 

diagram for spectrum mask measure-

ment is shown in Figure 7. 

Three steps for measuring the  

spectrum mask are as follows:

A.  Measure the frequency response 

of the output ilter using a net-

work analyzer or a combination of 

signal source and signal analyzer.

B. Measure the signal transmitted at 

point A as shown in Figure 7.

C. Apply amplitude correction on 

spectrum value measured in Step 

B using the ilter’s response from 

Step A.

Method 2:  When the transmitter 

does not have an output filter, an 

external filter with a band-block filter 

frequency response should be added 

after the transmitter for measurement 

arrangement as shown in Figure 8.

The steps for measuring the spectrum 

mask are as follows:

A.  Measure the frequency response 

of the output ilter using a net-

work analyzer or a combination of 

signal source and signal analyzer.

B.  Measure the signal transmitted at 

point B as shown in Figure 8.

C.  Apply amplitude correction on 

spectrum value measured in Step 

B using the ilter’s response from 

Step A.

The correction data is typically a table 

of the filter’s frequency response in 

dB, at a number of frequency points 

across the band. 

The correction data is typically a table 

of the negative values of this band-

block filter’s frequency response in 

dB, at a number of frequency points 

across the band.

COFDM 

exciter
Power  

ampliier
Output 

ilter
Input 

signal

Signal 

analyzer
Attenuator

DVB-T/H/T2 transmitter (UUT)

RF output

A

Power 

ampliier
External 

ilter
Input 

signal

Signal 

analyzer
Attenuator

DVB-T/H/T2 transmitter (UUT)

RF output BCOFDM 

exciter
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Instructions Keystrokes

On the X-Series:

Select the spectrum mask view [View/Display] {Spectrum Mask}

Input the value of the attenuator 

(for real DVB-T transmitter)
[Input/Output] {External Gain} {Ext Preamp}

Recall or edit the correction table
[Input/Output] {More 1 of 2} {Corrections} {Edit} 

or [Recall] {Data}

Turn the correction on [Input/Output] {More 1 of 2} {Corrections} {On}

Figure 9. Channel power measurement with spectrum mask view before applying 

amplitude corrections

Figure 10. Channel power measurement with spectrum mask view after amplitude 

corrections

Note: In spectrum mask view, if the 

bandwidth is not 8 MHz, the mask 

trace will not be displayed and a  

“No Result” message will be 

displayed, because the spectrum 

mask for those cases is not currently 

defined in the specs. 
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Demonstration 3:

Adjacent channel power (ACP)

Adjacent channel power can  

measure and report the power in one 

or more transmit channels. The text 

window shows the total power within 

defined carrier bandwidth and at 

given frequency offsets on both sides 

of the carrier frequency. The ACP 

measurement results should look  

like Figure 11. 

Figure 11. ACP measurement with noise correction on

Instructions Keystrokes

On the X-Series in DVB-T/H with T2 mode:

Set the center frequency [FREQ Channel] {Center Freq} {474} {MHz}

Select the radio standard under test and 

channel bandwidth

[Mode Setup] {Radio Std} {DVB-T}  

[Mode Setup] {Channel BW} {8 MHz}

Activate adjacent channel power  

measurement
[Meas] {ACP}

Compare the measurement result with 

noise correction turned on (default is off). 

A better ACP result is achieved with noise 

correction on (Figure 11)

[Meas Setup] {More 1 of 2}  

{Noise Correction On}
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Demonstration 4: 

Power stat CCDF)

The power stat complementary  

cumulative distribution function 

(CCDF) is a statistical method used to 

interpret the peak-to-average ratio of 

digitally modulated noise-like signals. 

It is a key tool for power ampliier 

design for DVB-T/H/T2 transmitters, 

which is particularly challenging be-

cause the ampliier must be capable 

of handling the high peak-to-average 

ratio while maintaining good adjacent 

channel leakage performance. 

Figure 12. Power stat CCDF measurement

Figure 13. Power stat CCDF measurement with reference trace

Instructions Keystrokes

On the X-Series in DVB-T/H with T2 mode:

Set the center frequency [FREQ Channel] {Center Freq} {474} {MHz}

Select the radio standard under test and 

channel bandwidth

[Mode Setup] {Radio Std} {DVB-T} 

[Mode Setup] {Channel BW} {8 MHz}

Activate the power stat CCDF measurement [Meas] {Power Stat CCDF}

Store a reference trace [Trace/Detector] {Store Ref Trace}

Turn on reference trace [Trace/Detector] {Ref Trace On}
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Demonstration 5: 

Spectrum emission mask

The spectrum emission mask (SEM) 

measurement can compare the total 

power level within the defined car-

rier bandwidth and the given offset 

channel on both sides of the carrier 

frequency to levels allowed by the 

standard when there is a digital TV 

signal in an adjacent channel. This 

measurement refers to the design of 

the power amplifier in the DVB-T/H/

T2 transmitter, and it is a key mea-

surement linking amplifier linearity 

and other performance characteristics 

to the stringent system specifications.

For a detailed explanation of how 

to make spectrum emission mask 

measurements, please refer to the 

descriptions in the channel power 

measurement and spectrum mask 

view sections.

Note: In the spectrum emission mask 

measurement, if the bandwidth is not 

7 MHz or 8 MHz, the mask trace will 

be displayed as a horizontal line on 

the top of the screen. You can then 

set the mask trace manually through 

[Meas Setup] {Offset/Limit}. 

Note: Unless otherwise declared by 

the manufacturer, you should use 

the noncritical case to measure a 

transmitting signal; use the critical 

case when the television channels 

are adjacent to other services (low 

power or receive only).

Instructions Keystrokes

On the X-Series in DVB-T/H with T2 mode:

Set the center frequency [FREQ Channel] {Center Freq} {474} {MHz}

Select the radio standard under test and 

channel bandwidth

[Mode Setup] {Radio Std} {DVB-T}  

[Mode Setup] {Channel BW} {8 MHz}

Activate spectrum emission mask  

(non-critical case default)
[Meas] {Spectrum Emission Mask}

Input the value of the attenuator  

(for real DVB-T transmitter)

[Input/Output] {External Gain} {Ext 

Preamp}

Recall or edit the correction table

[Input/Output] {More 1 of 2} 

{Corrections} {Edit} or

[Recall] {Data}

Turn correction on
[Input/Output] {More 1 of 2} 

{Corrections} {On}

Measure spectrum emission mask in  

critical case
[Meas Setup] {Limit Type} {Critical}
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Figure 14. Spectrum emission mask measurement in a non-critical case after amplitude 

correction

Figure 15. Spectrum emission mask measurement in a critical case after amplitude correction 
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Demonstration 6: 

DVB-T/H modulation  
accuracy

Measurement of modulation accuracy 

and quality are necessary to meet 

DVB-T/H defined tests and ensure 

proper operations of the transmitters. 

Error vector magnitude (EVM) and 

modulation error ratio (MER) are 

defined in DVB-T/H to present the 

total signal degradation including 

noise, interferences, or distortions at 

the input of a commercial receiver’s 

decision circuits to give an indication 

of that receiver’s ability to correctly 

decode the signal. EVM is a measure-

ment parameter for evaluating the 

quality of a modulation, and it is 

widely used in digital communications.  

MER is a representation of the 

distance between measured and 

theoretical constellation points,  

which is an indicator of noise, inter-

ferences, or distortions on a signal. 

MER is usually used in broadcasting 

applications. MER and EVM can 

convert each other.

The Keysight X-Series DVB-T/H 

modulation accuracy measurement 

provides many methods for measuring 

the errors in a DVB-T/H transmitter. 

In the measurements, you can  

measure the EVM, MER, magnitude 

error, phase error, and more.

Available views and traces in  

modulation accuracy:

 – I/Q measured polar graph view 

(Figure 16): A view of I/Q measured 

data of the selected sub-carriers

 – Results metrics (left)

 – I/Q measured polar graph (right)

 – I/Q error view (Figure 17): A view 

of computed error vector between 

corresponding symbol points in the 

I/Q measured and I/Q reference 

signals

 – MER/EVM vs. sub-carrier/

frequency view (top left)

 – Spectrum (top right)

 – I/Q measured polar graph  

(bottom left)

 – Results metrics (bottom right)

 – Channel frequency response view 

(Figure 18):

 – Amplitude vs. sub-carrier (top)

 – Phase vs. sub-carrier (middle)

 – Group delay vs. sub-carrier  

(bottom)

 – Channel impulse response view 

(Figure 19): A view of the state 

of the channel including two 

windows:

 – Peak table (left)

 – Amplitude vs. time (right)

 – TPS decoding view (Figure 20): 

TPS decoding graph shows original 

bits of TPS and the information 

decoded from TPS

 – BER results view (Figure 21): 

Summary of non real-time BER 

results

 – MER monitor view (Figure 22): 

Monitor of the MER results over 

time while detailed information and 

raw data for the failed MER are 

recorded.

 – Result metrics view (Figure 23): 

Summary of all the result metrics
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Instructions Keystrokes

On the X-Series in DVB-T/H with T2 mode:

Set the center frequency [FREQ Channel] {Center Freq} {474} {M Hz}

Select the radio standard under test and 

channel bandwidth

[Mode Setup] {Radio Std} {DVB-T}  

[Mode Setup] {Channel BW} {8 MHz}

Activate modulation accuracy measurement [Meas] {DVB-T/H Mod Accuracy}

Select demodulation options [Mode Setup] {Auto Detect}

Observe the I/Q measured polar vector 

display and quantitative data (Figure 16)

[View/Display] {IQ Measured Polar 

Graph}

Switch to the IQ error view (Figure 17) [View/Display] {I/Q Error (Quad View)}

View the channel frequency response 

(Figure 18)

[View/Display] {Channel Frequency 

Response} [Meas Setup] {Advanced} 

{Equalization On}

View the channel impulse response and 

turn on the equalization (Figure 19) 

[View/Display] {Channel Impulse 

Response} [Meas Setup] {Advanced} 

{Equalization On}

View the TPS decoding (Figure 20) [View/Display] {TPS Decoding}

View BER results (Figure 21)
[View/Display] {More 1 of 2}  

{BER Results}

View the MER monitor results (Figure 22) 
[View/Display] {More 1 of 2}  

{MER Monitor}

View result metrics (Figure 23)
[View/Display] {More 1 of 2}  

{Result Metrics}

Note 1:  If the current measurement 

is DVB-T2 Mod Accuracy, the DVB-T 

and DVB-H keys are grayed out. In 

this case you need to switch to other 

measurements before changing the 

radio standard.

Note 2:  In the I/Q error view, to dis-

play the value of carrier suppressions, 

set the I/Q Mismatch mode to be 

{Std} using keystrokes [Meas Setup] 

{Advanced} {I/Q Mismatch} {Std}.

Note 3:  The peak table window in 

channel impulse response view is 

very helpful in identifying the multi-

paths existing in the channel.  

Figure 24 is an example of a four-path 

channel with 0, 10, 20, and 30 µs 

delay respectively.

Note 4:  In the MER monitor view, if 

the limit line (Meas Setup, More 1  

of 2, MER Monitor) is turned on and 

the current MER result is lower than 

the limit, the corresponding failure 

raw IQ data for the specific measure-

ment will be saved to the directory 

“D:\userdata\DVB-TH\rawdata,” 

which can be used by the capture 

buffer of the X-Series signal analyzer 

for future research. During the moni-

tor process, a log file, including all the 

MER results, time information, and 

failure data path, is also saved to the 

directory “D:\userdata\DVB-TH.”
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Figure 16. Modulation accuracy measurement with I/Q measured polar graph view

Figure 17. Modulation accuracy measurement with I/Q error view

Figure 18. Modulation accuracy measurement with channel frequency response view
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Figure 20. Modulation accuracy measurement with TPS decoding view

Figure 19. Modulation accuracy measurement with channel impulse response view

Figure 21. Modulation accuracy measurement with BER results view
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Figure 23. Modulation accuracy measurement with results metrics view 

Figure 24. Four-path channel

Figure 22. MER monitor view
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Demonstration 7: 

DVB-T2 modulation accuracy

The DVB-T2 modulation accuracy 

measurement enables you to demod-

ulate the DVB-T2 signals, providing 

results like MER, EVM, magnitude 

error, phase error, L1 signaling infor-

mation, and so on. The demodulation 

parameters of the input DVB-T2 signal 

can be either auto-detected by the 

instrument using the L1 signaling 

data or set up manually. 

During the demodulation process, 

an internal periodic trigger, with the 

period of a DVB-T2 frame, is used 

as a reference to synchronize and 

demodulate the DVB-T2 signals. 

Available views and traces in DVB-T2  

modulation accuracy measurement:

 – I/Q measured polar graph view 

(Figure 25): A view of I/Q measured 

data of the specified sub-carriers 

and PLP index. 

 – Results metrics (left): Calculated 

using the overall data

 – I/Q measured polar graph (right): 

Constellation graph for the speci-

fied sub-carrier range and PLP ID

 – I/Q error view (Figure 26): A view 

of computed error vector between 

corresponding symbol points in the 

I/Q measured and I/Q reference 

signals

 – MER/EVM vs. Sub-carrier/

Frequency view (top left): 

Calculated using the overall data

 – L1 signaling decoding results  

(top right)

 – I/Q measured polar graph  

(bottom left): Constellation graph 

for the specified PLP index

 – Results metrics (bottom right): 

A summary of results calculated 

using the specified PLP index

 – Channel frequency response view 

(Figure 27):

 – Amplitude vs. sub-carrier (top)

 – Phase vs. sub-carrier (middle)

 – Group delay vs. sub-carrier  

(bottom)

 – Channel impulse response view 

(Figure 28): A view of the state of 

the channel

 – Peak table (left)

 – Channel impulse response trace 

(right)

 – L1 signaling view (Figure 29)

 – MER monitor view (Figure 30): 

Monitor of the MER results over 

time while detailed information and 

raw data for the failed MER are 

recorded 

 – Result metrics view (Figure 31): 

Summary of all the result metrics
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Instructions Keystrokes

On the X-Series in DVB-T/H with T2 mode:

Set the center frequency [FREQ Channel] {Center Freq} {474} {MHz}

Select the radio standard under test and 

channel bandwidth

[Mode Setup] {Radio Std} {DVB-T2}  

[Mode Setup] {Channel BW} {8 MHz}

Activate the DVB-T2 modulation accuracy 

measurement

[Meas] {DVB-T2 Mod Accuracy}

Set the instrument to auto-detect the 

demodulation parameters 

[Meas Setup] {Auto Detect} {On}

Synchronize the start of the T2 frame of 

the input DVB-T2 signal with the signal 

analyzer’s internal periodic trigger

[Meas Setup] {Sync Frame Now}

View the I/Q measured polar graph 

results (Figure 25)

[View/Display] {IQ Measured Polar Graph}

View the I/Q error results and specify the 

PLP index to view (Figure 26)

[View/Display] {I/Q Error (Quad View)}

View the channel frequency response 

(Figure 27)

[View/Display] {Channel Frequency 

Response}

View the channel impulse response and 

turn on the equalization (Figure 28)

[View/Display] {Channel Impulse 

Response} [Meas Setup] {Advanced} 

{Equalization} {On}

View the L1 signaling information  

(Figure 29)

[View/Display] {L1 Signalling}

View the MER monitor results (Figure 30) [View/Display] {More 1 of 2}  

{MER Monitor}

View the result metrics (Figure 31) [View/Display] {More 1 of 2}  

{Result Metrics}

Figure 25. I/Q measured polar graph view

Note 1:  If the current measurement  

is DVB-T/H mod accuracy, the DVB-T2 

key is grayed out, you need to switch 

to other measurements before  

changing the radio standard.

Note 2:  In the right bottom window 

of IQ error view, the peak values for 

EVM, MER, Mag Err, and phase error 

are all displayed as “---” because 

constellation rotation are used in the 

current PLP.

Note 3:  In the MER monitor view,  

if the limit line (Meas Setup, More  

1 of 2, MER Monitor) is turned on and 

the current MER results is lower than 

the limit, the corresponding failure 

raw IQ data for the specific measure-

ment will be saved to the directory  

“D:\userdata\DVB-T2\rawdata,” 

which can be used by the capture 

buffer of the X-Series signal analyzer 

for future research. During the monitor 

process, a log file, including all the 

MER results, time information, and 

failure data path, is also saved to the 

directory “D:\userdata\DVB-T2.”
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Figure 26. I/Q error view

Figure 27. Channel frequency response view

Figure 28. Channel impulse response view
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Figure 29. L1 signaling view

Figure 30. MER monitor view

Figure 31. Result metrics view
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Demonstration 8: 

Spurious emissions

The spurious emissions measure-

ment identifies and determines the 

power level of spurious emissions 

in frequency bands defined in ETSI 

EN 302 296. This measurement can 

verify the ability of the transmitter 

to limit the interference caused by 

unwanted transmitter effects to 

other systems operating at frequen-

cies away from the carrier frequency.

In the Keysight PXA/MXA/EXA/

CXA, the range of frequencies to 

search for spurs is user-adjustable, 

up to 200 spurs can be reported in a 

result table.

Note: The failed point in Figure 32 is 

the actual transmitted signal with the 

center frequency of 474 MHz. To avoid 

seeing this, you can either set the 

range table not to cover the frequency 

band containing the transmitted 

signal or connect a filter between the 

transmitter and the instruments to 

remove the undesired signal.

Note: The limit parameter is different 

depending on the mean power of the 

transmitter. Thus before measuring 

spurious emissions, you should set 

the mean power of the transmitter 

using [Meas Setup] {CH Mean Power}.

Figure 32. Spectrum emissions measurement

Instructions Keystrokes

On the X-Series in DVB-T/H with T2 mode:

Set the center frequency [FREQ Channel] {Center Freq} {474} {MHz}

Select the radio standard under test and 

channel bandwidth

[Mode Setup] {Radio Std} {DVB-T}  

[Mode Setup] {Channel BW} {8 MHz}

Activate spectrum emission mask [Meas] {Spectrum Emissions}

Set mean power of the transmitter [Meas Setup] {CH Mean Power}

Edit the range table as needed [Meas Setup] {Range Table}
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Demonstration 9: 

Monitor spectrum

The monitor spectrum measurement 

is used as a quick, convenient means 

of looking at the entire spectrum. 

While the look and feel is similar 

to the spectrum analyzer mode, the 

functionality is greatly reduced for 

easy operation. The main purpose 

of the measurement is to show the 

spectrum. 

Instructions Keystrokes

On the X-Series in DVB-T/H with T2 mode:

Set the center frequency [FREQ Channel] {Center Freq} {474} {MHz}

Select the radio standard under test and 

channel bandwidth

[Mode Setup] {Radio Std} {DVB-T} 

[Mode Setup] {Channel BW} {8 MHz}

Activate monitor waveform measurement [Meas] {Monitor Spectrum}

Figure 33. Waveform measurement with RF envelope view
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Demonstration 10: 

IQ waveform

Waveform measurement is a generic 

measurement for viewing the input 

signal waveforms in the time domain. 

Under this measurement there is 

also an I/Q waveform window, which 

shows I and Q signal waveforms in 

parameters of voltage versus time to 

disclose the voltages, which comprise 

the complex modulated waveform of a 

digital signal. The waveform measure-

ment can also be used to perform 

general-purpose power measurements  

with a high degree of accuracy. 

Instructions Keystrokes

On the X-Series in DVB-T/H with T2 mode:

Set the center frequency [FREQ Channel] {Center Freq} {474} {MHz}

Select the radio standard under test and 

channel bandwidth

[Mode Setup] {Radio Std} {DVB-T} 

[Mode Setup] {Channel BW} {8 MHz}

Activate IQ waveform measurement

(RF envelope default)
[Meas] {IQ Waveform}

View the I/Q waveform [View/Display] {I/Q Waveform}

Figure 34. Waveform measurement with RF envelope view

Figure 35. Waveform measurement with I/Q waveform view
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